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Frequently Asked Questions and Answers
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. What is the definition of a Major New Project?

The TRAC defines Major New Capacity projects as those projects greater than $12
million which increase the capacity of a transportation facility or reduce congestion. All
projects that cost ODOT greater than $12 million, request Major New funding, and add
capacity to a transportation facility must come before the TRAC. This definition includes
all new interchanges proposed for economic development or local access, any
significant interchange modifications, bypasses, general purpose lane additions,
intermodal facilities, major transit facilities, or Intelligent Transportation Systems (ITS).

Examples of eligible projects:

e Adding an additional lane on a state highway or interstate

e Adding an additional lane on bridges

e New interchanges

e New facilities that bypass congested state highways or interstates
e New rail lines for public transportation

e Capital cost for ITS facilities

e Intermodal port and rail projects

Examples of non-eligible projects:

e Widen a road from 10-foot lanes to 12-foot lanes
e Purchasing buses or other rolling stock

e Turning lane improvements

e Local road improvements

e Project with a total project cost under $12 million

Who Manages the Major New Capacity Program?

The Major New Capacity project selection process operates under the purview of the
Transportation Review Advisory Council (TRAC). The council was established by Ohio
Revised Code in 1997 to help ODOT develop and modify a project selection process and
which approves major new projects for funding.

The TRAC has nine members and is chaired by the Director of the Ohio Department of
Transportation. Six members are appointed by the Governor and one each by the
speaker of the Ohio House of Representatives and the president of the Ohio Senate.
Members have overlapping terms. The Director provides funds for new construction
only after assuring that system preservation needs have been met. The use of the new
construction funds is the responsibility of the TRAC, but the TRAC does not have
authority over other aspects of the Department of Transportation.
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Frequently Asked Questions and Answers

5. How can | obtain a Major New Project Application?
The Major New Project Application can be obtained by downloading it on the ODOT
website at www.dot.state.oh.us/trac/ or by contacting the TRAC Coordinator:

Mail: Phone/Email:

Tim McDonald, PE Phone: (614) 466-8981

Ohio Department of Transportation Fax: (614) 728-9358

1980 West Broad Street Email: TRAC@dot.state.oh.us

Columbus, Ohio 43223

6. When are Project Applications due?
Project Applications are due no later than July 15, 2011. Please see the Submission
Instructions outlined on page 29 of this document for further details.

7. How are projects nominated for the Major New Program?
The TRAC does not initiate projects. It reviews and ranks projects submitted to it.
Projects are submitted/nominated by completing the Major New Project Application.
Projects may be submitted/nominated by:

e The Ohio Department of Transportation
e Metropolitan Planning Organizations

e County Engineers

e Transit Authorities

e County Commissioners

e Municipalities

e Port Authorities

8. When should | submit a TRAC application?
The Project Sponsor should submit an application for:

e New projects which meet the Major New Project definition (see page 2) and
is a priority for the region

e Existing Tier Il projects if the project sponsor seeks funding for additional
project phases

9. Should | make a presentation before the TRAC?
The TRAC will hold public hearings around the state in September and October. It is not
necessary, however, to make a presentation in order for your project to be considered
for funding. The TRAC has funded projects where no formal presentation was made.
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Please review the following guidelines PRIOR to completing the application. The information
provided in the following document will guide the applicant step-by-step through the
application process.

Note 1:

Information should be entered on the application in the yellow areas only. Please do not edit,
modify, or recreate the form. Only the original Excel Application will be accepted for
consideration. Also, except were directed, please do not add rows or columns to the tables.
Doing so may delay the processing of your application.

Note 2:

Prior to beginning the application, please contact the District to verify the subject project meets
the funding eligibility guidelines listed on page 7 (TRAC Funding Eligibility) of the TRAC Policy
and Procedures.

Note 3:

Mapping requirements outlined under the Community and Economic Growth and Development
Factors are required for submission. An application will be considered incomplete without the
associated maps. If a sponsor has questions on what content is required for the mapping, please
contact the Office of Systems Planning and Program Management for assistance.

Note 4:

Please do not submit paper copies and/or binders of information. Paper copies of the
applications are NOT required. The Department requires the application to be electronic in an
effort to minimize preparation expenses and expedite project management, review, and scoring.

Note 5:

Signed (ink) copies of the application are no longer required. The electronic transmittal of data
from the sponsor to the Department (i.e. email, DVD, etc) is accepted as an official record of
intent. MPO’s will be contacted by the District via email to acknowledge each project (if
applicable). Upon receipt and review of the application, the MPO will be asked to respond via
email to the District either acknowledging or commenting on the project. The email response
will be retained as the official response from the MPO.

Note 6:

Upon completion of the TRAC application, the sponsor shall submit all associated project
information directly to the District Office. The District will review the application, mapping, and
related attachments and communicate directly with the sponsor regarding any questions. The
District Office will be responsible to officially submit the application in electronic format to the
ODOT Central Office Server.

Once complete, the District will email the TRAC inbox notifying the TRAC Staff that the

application is ready for processing. Applications submitted directly to the TRAC inbox without
District review and concurrence will not be accepted.
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Download /Access the 2011 TRAC Application

1. Download the current application from the following web link:

http://www.dot.state.oh.us/trac/Pages/NewTRACApplicationGuidelinesandApplicati
onForms.aspx

2. Save the application to a local directory on your computer
3. Once the application is saved, open the file using Microsoft Excel

4. The application will open, and the following dialog box will display:

TRAC Form [
Please Mote: This TRAC Application form will expire after Friday,
! W 7/15/2011.
5. Select > OK

All data will be locked and not able to be edited following July 15, 2011. The TRAC
application may be adjusted on a year to year basis, and the expiration limit will
prevent future applications from using previous versions of the Excel file for TRAC
submission.

6. Next, enable the Macro Option to ensure the Excel VBA routines function properly
per the instructions provided below. [If the Macro Functionality is not enabled, the
spreadsheet will not work correctly.

a. From the Excel File Menu advance the following steps:

]| = (4
Home Insert

i. Select File > Options > Trust Center > Trust Center Settings

Macro Settings

Disable all macros without notification
Disable all macros with notification
Disable all macros except digitally signed macros
@ Enable all macros [not recommended; potentially dangerous code can runj

ii. Within the Macro Settings as shown above, Select > Enable all
macros > OK
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Application Instructions

2011 TRAC Project Application

General Information

New Tierl Tier 2
PREVIOUS TRADT STATLIS 1rtersrremmca sessrssessesssemas sessssess sesasssusmss sessss sessusssssesassssssssssasmmsssssssssessns b sessssssssssesens b ssssssssssssnne b
Proposed TRAC STATUS v crsere s sesscesssssrsssssasssscerens VSRS SN &

ODOT District: || county: [ | ODOT PID:

Previous TRAC Status
Enter the project’s current TRAC status (“Tier 1”7 or “Tier 2”). If the project is not currently
funded by the TRAC, enter “New.”

Proposed Status
Enter “Tier 1” if the request includes funding for construction; otherwise enter “Tier 2”.

ODOT District
Enter the ODOT District for the project. (The field will display a drop down list prompting the
user to select their respective District.)

County:
Select the county which the project primarily resides. (Once the ODOT District is selected, the
County field will auto filter the list of counties associated with the respective District.)

ODOT PID

Enter the ODOT assigned five digit Project ID number (or PID). Enter only one PID per
application. PID’s for related projects should be entered in the Project Relationship table,
below. If new or additional TRAC funding is being requested for multiple projects/PID’s, submit
multiple applications (one application for each project/PID).
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ILﬂCﬂI Jurisdictions [Countics, Townzhips, andfor Cities]

Fﬂcilit\f Mame [Roste, Rail, Terminal, or Port Hame)

Principal Agency

Participating Agencies

Local Jurisdiction
Enter the local jurisdiction where the project primarily resides (i.e. Cities, Counties, Townships,
etc)

Facility Name

Enter the route, rail, terminal, or port name by which the project is known. For roadway
projects, include the route type (SR — state route; CR — county route; TR — township route) and
number, or the local road name.

Principal Agency

Enter agency name of the primary project sponsor. The TRAC discourages members of the
general public from nominating projects. Members of the general public who desire a project
should secure the support of a local governmental entity as the lead project sponsor to ensure
the project is compatible with local planning priorities.

Participating Agencies
Enter agency name(s) all of the project co-sponsors.
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Project Sponsor

First Name: Last Name:
Street Address: |
City: | | state: ZIP Code:

Phone Number: Email Addre55:|

Project Sponsor (Contact Person) / Phone Number / Street Address / City / State / Zip / Email
Address

Enter the name, mailing address, phone number and email address of the person to be
informed of all TRAC actions and public hearings.
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Project Description

Description of Work (100 word= or Less)

Pu rpDSE a"d NEEd [500 Words or Lesz) Hote: To Start 2 Hew Paragraph Type “Alt + Enter™

Description of Work
In 100 words or less, describe the basic facts of the work to be performed. Include the

descriptions and number of facilities to be constructed/reconstructed.

Purpose and Need for the Project
In 500 words or less, lay out the purpose and need for the project. This should be copied from
an existing planning or environmental document if available.
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Project Relationship

0DOoT PID Project Name Phases Included Ex. TRAC | TRAC List Date |TRAC List
Project Line No.
County-Foute-Section PS PE DD | BW | CO | Yes | Mo MARDDNTY
{~ {

List all other projects that are related to this project. For example:
e If part of the development for the current project/PID was performed under other
projects/PID’s, enter those other projects here
e If the current project/PID is phase of larger group of projects/PID’s, enter all of the other
projects in the group here

Enter one project on each row. Add additional rows as necessary by selecting the following icon
located in the right margin:

Click the Plus
Sign Below to
Add a Row.

Gt

ODOT Project ID
Enter the ODOT PID number for the related project.

Project Name

Enter the related project’s name. Generally the name includes the county, route number and
beginning log point (section). The project name should match the project name as it appears in
Ellis.

Phases Included
Select all of the phases that the project has or will perform. Possible phases are:
e PS—Planning Study
e PE —Preliminary Engineering
e DD — Detailed Design
e RW —Right of Way
e (CO - Construction

Existing TRAC Project
If this application relates to an existing project on a previous TRAC list, select Yes

TRAC List Date
If this application relates to an existing project on a previous TRAC list, enter the publication
date of the previous TRAC list.

TRAC List Line #
If this application relates to an existing project on a previous TRAC list, enter the line number of
the existing project on the previous TRAC list.
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Community and Economic Growth and Development Components
Component

Comment

Project Location Map is Attached, Map 1

Economic Impact Map is Attached, Map 2

Redevelopment Map is Attached, Map 3

Employment Map is Attached, Map 4

Land Use Plan {LUP) is Attached

LUP Coordinates with Transportation Plan

Zoning Supports Transportation Plan

On State/RPC/MPO Long Range Plan

Buisness Data Added to Map 4

a/iellis/NelliaNellisRellallel
s lellieNellieRellelRelNallell

Improves Investment and Employment

Percent of Developed Land, Map 3

* Sub-County 5 Year Unemployment Rate

* Sub-County 5 Year Poverty Rate

* - Optional. If omitted, the 5 year rates for the primary county will be obtained from the US Bureau of Labor Statistics
{www.bls.gov) and US Census Bureau (www.census.gov).

Supplemental Information

For purposes of scoring “Community and Economic Development Factors,” the following
additional information (maps) must be included with the application. The maps are to be at
least 8.5” x 11” but no larger than 11” x 17”. Submit one electronic copy in pdf format.

Project Location Map (Label as #1) is Attached

This map must include an aerial photograph overlay of the area (preferably color), and must
show the proposed project location. Also include defined labels for significant existing
infrastructure related to the project (i.e. major road names, nearby municipal boundaries) for
reference). Map 1 is required and must be included with the application to obtain scoring

Economic Impact Map (Label as # 2) is Attached

This map must denote the project’s immediate economic footprint with a geographic polygon
of the general economic influence area. The economic influence area must be defined in
cooperation with the responsible local economic development professionals (or state/regional
representatives if local economic development professionals do not exist). The map must also
label land use by general type (Industrial, Commercial/Office, Commercial/Retail, Residential,
Agriculture, Conservation, etc.), and show as applicable — Clean Ohio Revitalization Fund
Brownfield Projects, Clean Ohio Assistance Fund Brownfield Projects, Ohio Department of
Development Brownfield Revolving Loan Fund Projects, Ohio Job Ready Site Projects, University
System of Ohio institutions, private four-year universities, non-profit research institutions, and
Ohio Hub of Innovation and Opportunity (OHIO Hub) anchor institutions. As per the Policy &
Procedure manual, should the economic influence area be subject to further examination, the
TRAC will be the final arbiter of the quality of data submitted by the project applicant. Map 2 is
required and must be included with the application to obtain scoring.

Page 11 June 2, 2011



?/'-_,R_/’_ \ f‘, 2011 Project Application Guidelines

Redevelopment Map (Label as # 3) is Attached

This map must show the project location and denote with a geographic polygon the area
directly served by the project, consistent with the definition provided under the “Positioning
Land for Redevelopment” section on Page 16 of the Policy & Procedures. Additionally, the map
must label developed land and undeveloped land within the geographic polygon. If the defined
geographic area provided cannot be justified, the default area will be a one-mile radius around
the transportation improvement. ODOT Modeling & Forecasting Unit will utilize the geographic
polygon provided in Map 3 to model whether the project will reduce fuel consumption and if
ozone precursors are predicted to decrease. Map 3 is required and must be included with the
application to obtain scoring

Employment Map (Label as # 4) is Attached

This map should denote the project location and identify major employers by point and label
them by legal name. Smaller employers can be grouped and described by business sector.
Include the number of jobs associated with each employer or group. The geographic boundary
of the area should be the same as the area directly served by the project, as defined in Map 3.
Map 4 is required and must be included with the application to obtain scoring.

Land Use Plan (LUP) is Attached

Enter “Yes” or “No” according to whether a comprehensive land use plan, strategic plan,
thoroughfare plan, neighborhood plan, or master community plan adopted by the city, county,
or township has been included with the application. Although it is permissible to include the
entire Plan, only the portion of the Plan applicable to the area served by the project (as defined
in Map 3) must be included.

LUP Coordinates w/ Transportation Plan

Enter “Yes” or “No” according to whether the land use plan is coordinated with the
transportation plan or project. The Land Use Plan and Maps 1-4 will be used to verify accuracy
of the coordination.

Zoning Supports Transportation Plan

Enter “Yes” or “No” according to whether the appropriate city, county, or township has zoning
in place that is conducive to the project under consideration. A copy of the adopted zoning is
required and must be included with the application to obtain scoring.

On state/RPC/MPO Long Range Plan

Enter “Yes” or “No” according to whether the project is part of a metropolitan planning
organization (MPQO) long range plan, regional planning commission (RPC) or ODOT'’s Statewide
Transportation Plan.

% Developed Land (Map 3)

Based on Map 3, calculate the estimated percentage of developed acreage within the
geographic area served by the project. For purposes of definition, “developed” land means
property that had, or currently has, use as manufacturing, light industrial, warehouse,
commercial, or residential development, with associated infrastructure (such as water, sewer,
electricity), and which may also be classified as a brown field. “Undeveloped” land means
property that was never used for such development, has no buildings, public utilities or
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associated infrastructure, and might have had current or former use as cropland, pasture,
woodland, or other use that does not include roadway or utility services. Permanently
dedicated green space and cemeteries should be subtracted from the acreage of the
geographic area.

(It is the responsibility of the local project sponsor to attach the analysis and calculation of the
redevelopment percentage to the application.)

Business Data Added to Map 4
Enter “Yes” or “No” according to whether business data (employers with number of jobs) have
been labeled on Map 4.

Improves Investment & Employment
Enter “Yes” or “No” according to whether the project increases land value or employment in
the area served by the transportation project, considering:

e The extent to which the project serves an Ohio Job Ready Site, as designated by the
Ohio Department of Development. The project applicant must demonstrate the project
location on Map 2 in relation to the Job Ready Site location, and justify the assertion
that the transportation project improves access to the Job Ready Site.

e Evidence of direct private investment in real estate served by the transportation project
(within the economic impact area as defined in Map 2). Private investment is eligible if
it is from the previous five years or projected for the next two years. Such evidence
could include documents from private businesses or other tangible evidence of private
party commitment to develop/expand business in relation to the transportation
improvement.

e Evidence of employment growth resulting from the transportation project is defined as
prospective full-time equivalent, non-construction/non-project related positions that
will be created by businesses denoted in Map 4 or proposed business development
within the economic impact area denoted in Map 2. Evidence will be required to verify
projected employment growth and can take the form of either a survey of businesses or
commitment letters from a business.

e Direct local public investment in public infrastructure associated with the project (local
roads, sewer, water) that demonstrates confidence in the private sector’s plans or
commitment to build or expand, as associated with the transportation investment.

Sub-county 5 Year Unemployment Rate

Enter the sub-county/project area 5-year unemployment rate as a percentage. If omitted, the
5-year unemployment rate for the primary county will be obtained from the US Bureau of Labor
Statistics (www.bls.gov).

Sub-county 5 Year Poverty Rate

Enter the sub-county/project area 5-year poverty rate as a percentage. If omitted, the 5-year
poverty rate for the primary county will be obtained from the US Census Bureau
(www.census.gov).

(It is the responsibility of the project sponsor to attach documentation that defines the sub-
county area, and calculations of the unemployment poverty rate percentages.)
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Intermodal Connectivity
f the project connects different transportation modes, please describe the connections.

If project connects transportation modes, please explain how

Provide an explanation of how transportation modes will be directly connected by this project.
Simply stating the existence of other modal facilities within the project impact area is not
sufficient to be awarded points for intermodal connectivity.
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Road Facilities By NLFID
Begin Log End Log Primary
ODOT NLFID Point Point Location Termini
Yes | No
{ {

Note:
The ODOT District will enter the ODOT NLFID as required. The local project sponsor is_not
required to enter the NLFID.

If the Existing Road Facility is_not within the ODOT NLFID Inventory, please locate the facility
per the instructions outlined on Page 16.

ODOT NLFID

Enter the ODOT network linear feature identifier (NLFID) which uniquely identifies each
road in Ohio. If the NLFID is not known, enter the 3-character county abbreviation along
with the route type and number.

Note:
Enter one existing road facility per row. Add additional rows as necessary by selecting the
following icon located in the right margin:

Click the Plus
Sign Below to
Add a Row.

a

Note:
It is the responsibility of the project sponsor to complete all of the following columns for each
existing road facility entered.

Begin Log Point
Enter the beginning log point (i.e. mile post) for the roadway improvement.

End Log Point
Enter the ending log point (i.e. mile post) for the roadway improvement.

Primary Road
For projects involving more than one road, enter “Yes” or “No” according to whether

this road is the primary road being improved. There should be only one primary route.

Location Termini
Enter a brief description of the work limits (i.e. From Broad St. to State St.).
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Facilities By Lat Long [Not within the NLFID Inventory)

sh Primary

o = B
MName or m o .
) ) = - L& 5 Location Termini

Designation E= = = =
m} m} = =

o o LE LE Yes | No

i i

Note:

If the Existing Road Facility is_not within the ODOT NLFID Inventory, please locate the facility
per the instructions outlined below.

Name or Designation

Enter the ODOT network linear feature identifier (NLFID) which uniquely identifies each road in
Ohio. If the NLFID is not known, enter the 3-character county abbreviation along with the route
type and number.

Begin Lat / Begin Lon / End Lat / End Lon
Enter the beginning and ending latitude and longitude for the existing roadway using Google
Maps as outlined below:

e Open Google Maps (Click the Link to the Right) > Google Maps
e Zoom into the location of the Begin Point of the Facility and right click on the
Begin Point.
o The following dialog box will be displayed with several options. Select >
"What's here?"

Directions from hers
Directions to here

Zoom in b
Zoom out
Center map here
What's hera?

Repart a problem
232 64
% — Kaufman|

o The (Latitude, Longitude) values will appear in the Search Field as shown
in the screen capture below:

Go .-gl'c MapsS  40.446604,-82.793913

'

<7
- Township Rd 232

\71)

==

o Input these values into the TRAC Application as required.
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Note:
It is the responsibility of the project sponsor to complete all columns for each existing road
facility entered.

Primary Road
For projects involving more than one new road, enter “Yes” or “No” according to
whether this road is the primary new road being constructed.

Location Termini
Enter a brief description of the limits of new roadway construction (i.e. From Broad St.

to State St.).

The Google Map associated with the project limits will automatically hyperlink the
location to the text.

Note:
Enter one existing road facility per row. Add additional rows as necessary by selecting the
following icon located in the right margin:

Click the Plus
Sign Below to
Add a Row.

it
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Mew Road Facilities

0] Primary
. z .
Mame or m o . bn

Designati = = s E Location Termini

esignation E’ 5’ = =

o o u‘i LE Yes | No

i ™

Name or Designation
Enter the ODOT network linear feature identifier (NLFID) which uniquely identifies each road in

Ohio. If the NLFID is not known, enter the 3-character county abbreviation along with the route
type and number.

Begin Lat / Begin Lon / End Lat / End Lon
Enter the beginning and ending latitude and longitude for the new roadway using Google Maps

as outlined below:

e Open Google Maps (Click the Link to the Right) > Google Maps
e Zoom into the location of the Begin Point of the Facility and right click on the

Begin Point.
o The following dialog box will be displayed with several options. Select >

"What's here?"

Directions from here

Directions to here

Zoom in b
Zoom out
Center map here

What's here?

Report a problem
232 m—
% — Kaufman|

o The (Latitude, Longitude) values will appear in the Search Field as shown
in the screen capture below:

Google maps  40.446604.-82.793913

O
. Towns hip Rd 232 %

1)

=50

o Input these values into the TRAC Application as required.
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It is the responsibility of the project sponsor to complete all columns for each new road facility
entered.

Primary Road
For projects involving more than one new road, enter “Yes” or “No” according to
whether this road is the primary new road being constructed.

Location Termini
Enter a brief description of the limits of new roadway construction (i.e. From Broad St.

to State St.).

The Google Map associated with the project limits will automatically hyperlink the
location to the text.

Note:
Enter one existing road facility per row. Add additional rows as necessary by selecting the

following icon located in the right margin:

Click the Plus
Sign Below to
Add a Row.

it
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Transit Facilities
Peak Hour Existing Added Peak VMT

Transit Type and Route/Name Ridership Capacity Hour Capacity | Reductio

[Riders) [Feats) [Eeats)
[¥hT)

Transit Type and Route/Name
Enter the transit type (rail, bus) and route/name associated with the transit facility.

Peak Hour Ridership
Enter the element ridership during the peak work commute periods (i.e. when highway V/C
ratios are measured).

(It is the responsibility of the project sponsor to attach documentation that provides the
calculations and methodology used to determine the peak hour ridership.)

Existing Capacity (Seats)
Enter the existing capacity of the current transit system by listing the total number of seats
available for riders.

Added Peak Hour Capacity (Seats)

This measure allows the TRAC to evaluate the extent to which the proposed project will
increase the capacity of the transit service. Enter the increase in the number of seats available
added in a single peak hour.

VMT Reduction
Enter an estimate of the reduction in vehicle miles traveled within the corridor served by the
element.

Most project feasibility studies will readily provide such estimates of a project’s impact and the
values provided in these reports can be used. If a Project Sponsor does not have this
information, the Department will calculate the VMT reduction based on the Statewide Traffic
and Forecasting Model

(It is the responsibility of the project sponsor to complete all columns for each transit facility
entered and attach documentation that provides the calculations and methodology used to
determine the VMT reduction.)

Note:
Enter one transit facility per row. Add additional rows as necessary by selecting the following
icon located in the right margin:

Click the Plus
Sign Below to
Add a Row.

oR
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Freight Facilities
Ex. Freight Volume/ Reductionin | Freight
: Ex. Facility Capacity Ratio | Truck Miles |Capaacity
Freight Type and Route/Name Traveled Increase
[.xx] [ThT] [TELWDay]

Freight Type and Route/Name
Enter the type of intermodal freight project and the route/name associated with the
improvement.

Existing Freight Volume / Existing Facility Capacity Ratio
Enter the calculated congestion ratio for intermodal freight element based on the volume of
freight it carries, compared with its capacity. Refer to the table below for appropriate inputs.

Input Road Port Rail Intermodal
Traffic Volume Port Volume Train traffic, .
Terminal throughput:
e Autos e Break bulk tons expressed as: .
. . e Containers (TEUs)
Volume e Trucks e Containers (TEUs) o #of railcars
. e Other transfer measure
e Peak hour | e Dry bulk tons o #of trains (e.g. rail/barge, rail/truck)
factor e Liquid bulk gallons e Train length & g
Per hour or per day
e Type of road capacity (expressed
e Number of in railcars, trains,
lanes Per hour or per diem | etc.), as controlled | Per hour or per day transfer
Capacity e Speed limit capacity expressed in | by: capacity, for example,
e Terrain tons, TEUs, etc. o # of tracks containers (TEUs) per day
® % truck traffic e Signalization
e Etc. e At grade
crossings

(It is the responsibility of the project sponsor to attach documentation that provides the
calculations and methodology used to determine the existing volume to capacity ratio.)

Reduction in Truck Miles Traveled (TMT)

Truck reduction on an individual facility can be easily derived. The volume of freight moving by
rail or port can be converted into a number of trucks by equating one twenty-foot equivalent
unit (TEU) to one truck. The applicant can use this conversion factor to represent the number of
trucks reduced from an adjacent roadway, and calculate this reduction in terms of total truck
miles travelled from the facility to the state line.

The other method is to calculate a regional truck traffic reduction, which would be represented
as the reduction of truck miles travelled for the area of impact defined by the project applicant.
For example, a region could be within an MPO, within the state of Ohio, or within some subarea
designated by the project applicant. A feasibility study is required to validate this calculation
and will be required as an attachment to the application.

(It is the responsibility of the project sponsor to attach documentation that provides the
calculations and methodology used to determine the reduction in TMT.)
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Freight Capacity Increase
Enter the total number of TEU’s serviced by the freight facility.

The TRAC will consider increase freight Capacity by capturing the total increased number of
TEU’s to be processed through a freight facility. The twenty-foot equivalent unit (often TEU or
teu) is an inexact unit of cargo capacity often used to describe the capacity of container ships
and container terminals. It is based on the volume of a 20-foot-long (6.1 m) intermodal
container, a standard-sized metal box which can be easily transferred between different modes
of transportation, such as ships, trains and trucks.

(It is the responsibility of the project sponsor to attach documentation that provides the
calculations and methodology used to determine the TEU calculations.)

Note:
Enter one freight facility per row. Add additional rows as necessary by selecting the following
icon located in the right margin:

Click the Plus
Sign Below to
Add a Row.

oR
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Froject bevelopment

Actual or Proposed
Performed By

[Agency Mame]

Start Finish
Date Date

Project Phase

Planning Study, PS

Interchange Modification Study, IMS
Interchange Justification Study, 1JS
Preliminary Engineering/NEPA, PE
Detailed Design, DD

Right of Way / Utilities, RW

Performed By
Enter the agency name that has completed (or is assigned to complete) the corresponding

project phase.

Actual / Projected Start Date
Enter the actual or projected month and year for the beginning of each project phase. It will be

assumed that:
o Dates entered before the application date, indicate that the project phase has been

started
o Dates entered after the application date, indicate that the project phase has not yet

started

Actual / Projected Finish Date
Enter the actual or projected month and year for the completion of each project phase. It will

be assumed that:
o Dates entered before the application date, indicate that the project phase has been

completed
e Dates entered after the application date, indicate that the project phase is still under

development (or not started)
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Project Funding: Non-TRAC and Future TRAC

Funding Sources (Non-TRAC)

Source Project Phase Amount
— CDOT | Federal
Description Funds [Earmark| PS PE DD RW o (Dellurz)
i i i i i

When entering the funding data, the NON-TRAC funds will be entered as follows:
Funding Sources (Non TRAC)

Description
Enter the name of the funding source (MPO, Local, OPWC, etc)

ODOT Funds
Select if the funding source is ODOT (Yes/No)

Federal Earmarks
Select if the funding is a designated Federal Earmark (Yes/No)

Project Phase
Select the project phase which applies to the funding source. Only one funding source
may be selected per phase.

Amount
Enter the amount (in dollars) assigned to the funding source

Note:
Enter one funding source per row. Add additional rows as necessary by selecting the
following icon located in the right margin:

Click the Plus
Sign Below to
Add a Row.

i

Once the data is entered, the values will automatically calculate and tabulate in the summary
table listed in the following section.
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Project Funding (ix Mitioss)

Project Bhase FY Mon-TRAC : TRAC Phase

Local oDoT Previous MNew Future Total

Planning Study, PS 50.000 50.000 50.000
Preliminary Engineering, PE $0.000 50.000 $0.000
Detailed Design, DD 50.000 50.000 50.000
Right of Way / Utilities, RW £0.000 £0.000 £0.000
Construction, CO $0.000 50.000 $0.000
Totals| %0.000 $0.000 $0.000 $0.000 $0.000 $0.000

When entering the funding data, the TRAC funds will be entered as follows:
Funding Sources (TRAC)

Fiscal Year

Enter the state fiscal year (which begins July 1) for the beginning of each applicable
project phase (e.g. 2012). Please double check that the state fiscal year is correct for
the Actual / Projected Begin date on the Project Development table. Project phases that
begin in the month of July (or later) are actually in the next state fiscal year (i.e. July
through December 2010 is actually part of state fiscal year 2011).

Non-TRAC Local Funding

The table will display the total amount of non-TRAC funding received or committed from
local sources (i.e. county, township, city, village, or private) by project phase. These
amounts are auto calculated from the values entered in the Funding Sources (Non-
TRAC) table.

Non-TRAC ODOT Funding

The table will display the total amount of non-TRAC funding received or committed from
federal or ODQOT sources by project phase. These amounts are auto calculated from the
values entered in the Funding Sources (Non-TRAC) table.

Previous TRAC
Enter the amount of existing TRAC funding received or committed by project phase.

New TRAC
Enter the amount of new TRAC funding requested with this application, by project
phase.

Future TRAC
Enter the amount of future TRAC funding by project phase that is not being requested

with this application, but will be requested at a later date with a future application.

Total
The total values will auto calculate based on the data entered for the various phases.
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Funding Notes: NON-TRAC and TRAC Funding

Note 1:
Attach a detailed cost estimate for each project phase that is not yet complete.

Note 2:

Please enter the project costs, by source, for each phase of project development along with the
calculations used to develop those costs. The TRAC realizes that, depending on the current
stage of project development, more or less detail may be available for calculating costs. Simply
provide the latest cost information available. It should be noted, however, that the TRAC will
expect greatest detail from applicants requesting Tier | (Construction) funding.

Costs for future phases of development should be inflated to the appropriate state fiscal year.
Inflation factors can be found on ODOT’s Office of Estimating website at:

http://www.dot.state.oh.us/Divisions/ConstructionMgt/Estimating/Pages/default.aspx
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ODOT District Acknowledgement
First Name: Last Mame:

District: Date: Phone Mumber:

First Name, Last Name
Enter the name of the of the District Planning and Engineering Administrator

District
Enter the ODOT District

Date
Enter the date

Phone Number
Enter the phone number of the District Planning and Engineering Administrator

Notes:
e Prior to submitting the final application to Central Office, please verify project sponsor
has provided a resolution endorsing the submittal of the TRAC application.

e If the resolution is not available by July 15, 2011 please coordinate delivery of the
resolution no later than August 1, 2011.
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MPO Information

MPO Agency: | | Individual Contacted:

Date District Received Email of MPO Acknowledgement:

Comments/Safety Rankings/Congestion Rankings/MPO Rankings:

MPO Agency
Enter the name of the Metropolitan Planning Organization.

Individual Contacted
Enter the name of the individual acknowledging this application.

Date District Received Email of MPO Acknowledgement
Enter date the District received the email reply from the MPO acknowledging the project

Comments
Enter any remarks or comments that the TRAC should consider with respect to this application.

Notes:

e MPO priorities for TRAC applications should be submitted to ODOT no later than
September 15™.
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Submission Instructions

In lieu of submitting paper copies to the Department, the following work flow is introduced
requesting electronic media and will be implemented for the 2011 TRAC Applications:

Application Preparation:

1. The project sponsor prepares the application per the instructions in the user guide.
2. The project sponsor submits the entire application, including supporting information
(i.e. documentation, endorsement letters, resolution, and maps) electronically to the

District for review. The original application must remain in Excel format while the
attachments are required in PDF file format.

MPO Acknowledgement (If applicable):

3. Following the District review, the District will send a copy to the MPO (if applicable)
requesting acknowledgement of the project(s).

4. The MPO will respond to the District via email (for record) confirming the project.

District Submission:

5. Once the project is approved by the District for final submission, the District will copy
the project files to the following directory location:

Files:
Project Application — Excel format
MPO Project Acknowledgement (Email) — PDF
Supporting Project Documentation — PDF
Directory Location:
O:\Planning\SPPM\Major New\ 2011 TRAC Applications
Note: Please place each application in a separate folder
6. After the files have been copied to the server, the District will email the TRAC inbox
advising the Office of Systems Planning and Program Management that the TRAC

applications are ready for processing.

Application Deadline:

7. Applications are due to Central Office (including MPO acknowledgement) by the close of
business July 15, 2011.
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